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DALAM RANGKA melaksanakan fungsi Kementerian PPN/Bappenas sebagai Instansi

Pembina Jabatan Fungsional Perencana (JFP), Pusat Pembinaan, Pendidikan, dan

Pelatihan Perencana (Pusbindiklatren), melaksanakan program capacity buiiding untuk

meningkatkan kompetensi dan upaya peningkatan kapasitas dan kualitas perencanaan

pembangunan yang sesuai dengan tuntutan masyarakat.

Penyelenggaraan kegiatan strategis tersebut dilaksanakan melalui program pendidikan

dan pelatihan (diklat) yang dilaksanakan oleh program studi (prodi) di perguruan tinggi,

baik di dalam negeri maupun luar negeri.

Mengingat semakin banyaknya program diklat yang diselenggarakan oleh

Pusbindiklatren, baik di dalam negeri maupun luar negeri, dan perkembangan teknologi

yang semakin pesat maka dirasakan perlu adanya peningkatan penyelenggaraan diklat

dengan memanfaatkan konsep e-learning untuk mendukung proses pembelajaran dalam

diklat. Oleh karena itu, Pusbindiklatren mengembangkan Sistem Informasi dan

Pembelajaran Elektronik Perencana (Sipena). Sistem ini pada dasarnya terdiri dari

software dan hardware untuk melaksanakan pembelajaran diklat yang diselenggarakan

oleh Pusbindiklatren. Untuk hardware telah dilakukan pengadaan alat, yaitu 1 set

Management Central Unit (MCU), 1 set immersive, dan 12 set video conference 2 layar

yang diletakkan di Kantor Kementerian PPN/Bappenas dan 8 prodi di 7 universitas.

Untuk software telah dibangun situs web dan aplikasi pembelajaran Sipena.

Dengan aplikasi pembelajaran Sipena, peserta diklat dapat mempelajari materi diklat,

mengerjakan kuis, membahas topik diklat, dan lain sebagainya yang berhubungan

dengan proses pembelajaran diklat sebelum memasuki kelas.

Sipena diharapkan dapat memberikan bahan ajar dan informasi yang lengkap bagi

pelaksana dan peserta diklat Pusbindiklatren, dalam rangka kelancaran pelaksanaan

studi yang diselenggarakan oleh seluruh perguruan tinggi yang bekerja sama dengan

Pusbindiklatren.

Demikian, semoga panduan ini dapat bermanfaat dan dapat digunakan sebaik-baiknya

oleh semua pihak yang terkait dengan pelaksanaan Sipena.

Jakarta, Agustus 2021

Dr. Guspika, M.B.A.

Kepala Pusbindiklatren Kementerian PPN/Bappenas
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PENDAHULUAN





Salah satu tugas pokok Pusat Pembinaan, Pendidikan, dan Pelatihan Perencana

Kementerian Perencanaan Pembangunan Nasional/Badan Perencanaan

Pembangunan Nasional (Pusbindiklatren Kementerian PPN/Bappenas) adalah

untuk melakukan pembinaan dan pengembangan Jabatan Fungsional Perencana

dan program pendidikan dan pelatihan bagi pegawai Kementerian PPN/Bappenas

serta perencana pusat dan daerah dalam rangka meningkatkan kompetensi

perencana dan kapasitas instansi perencana pusat dan daerah (KepmenPPN/KA

Bappenas No. 050/M.PPN/03/2002).

Selain hal tersebut Pusbindiklatren juga melaksanakan tugas untuk

memfasilitasi peningkatan kompetensi aparatur perencana pemerintah pusat

dan daerah untuk mempercepat desentralisasi dan otonomi daerah (KepmenPAN

No. 16/KEP/M.PAN/3/2001 tentang Jabatan Fungsional Perencana dan Angka

Kreditnya.

Dalam rangka pelaksanaan tugas pokok tersebut, Pusbindiklatren melakukan

kerja sama dengan mitra program studi (prodi)/lembaga di beberapa universitas

negeri terkemuka di Indonesia untuk pelaksanaan program pendidikan maupun

pelatihan dalam negeri/linkage. Selain itu, Pusbindiklataren juga bekerja sama

dengan beberapa universitas di luar negeri untuk pelaksanaan program

pendidikan maupun pelatihan luar negeri/linkage.

Untuk memperlancar pelaksanaan tugas pokok tersebut diperlukan sarana dan

prasarana yang dapat digunakan untuk melalukan koordinasi, pengendalian,

pemantauan, evaluasi, dan pembelajaran antara Pusbindiklatren dan mitra serta

antarmitra.
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A. Latar Belakang Sipena

B. Ruang Lingkup Sipena

Sipena adalah sistem pendidikan dan pelatihan (diklat) di bidang perencanaan

pembangunan yang memungkinkan peserta diklat dan pengajar tidak

bertatap muka secara langsung melalui proses pembelajaran menggunakan

berbagai sumber belajar dan media berbasis teknologi informasi dan komunikasi.

Sipena dibangun dan dikembangkan oleh Kementerian PPN/Bappenas untuk

mendukung dan memfasilitasi program peningkatan kapasitas sumber daya

manusia (SDM) aparatur perencana di pemerintah pusat dan daerah melalui

program pendidikan dan pelatihan.



Panduan Penggunaan Aplikasi Sipena

4

Sipena terdiri atas perangkat lunak (software dan sistem) dan perangkat keras

(hardware/peralatan). Perangkat lunak (software) yang digunakan termasuk situs

web dan aplikasi pembelajaran Sipena. Sementara perangkat keras (hardware)

yang digunakan termasuk peralatan, ruangan dan fasilitas, Standar Operating

Procedure (SOP), serta Panduan Penggunaan Aplikasi Pembelajaran Sipena untuk

peserta, program studi/lembaga pelaksana, dan pengajar.

Sistem yang digunakan dalam Sipena terdiri atas teknologi sinkronus dan

asinkronus. Teknologi sinkronus adalah cara pembelajaran yang memungkin

seluruh peserta didik hadir (meskipun di tempat yang berbeda) pada waktu yang

sama (melalui web conferencing, video conferencing, televisi pendidikan,

televisi instruksional, direct broadcasting-satellite/DBS, internet radio, live

streaming, telepon, ataupun VOIP). Adapun teknologi asinkronus adalah cara

pembelajaran yang memungkinkan peserta mengakses materi diklat pada jadwal

mereka sendiri sehingga lebih fleksibel. Peserta diklat tidak diharuskan untuk

bersama-sama aktif pada waktu yang sama (dapat menggunakan forum, e-mail,

rekaman video dan audio, bahan cetak, pesan suara/voice mail, dan faksimili).

C. Manfaat Sipena

Dengan adanya Sipena, manfaat secara umum yang akan diperoleh adalah

sebagai berikut.

• Menjembatani kesenjangan pendidikan. Sistem seperti ini sangat

membantu, terutama jika dikaitkan dengan permasalahan geografis negara

Indonesia yang terdiri dari berbagai pulau yang tersebar.

• Jangkauan yang luas. Dengan teknologi video conference diharapkan dapat

memperluas jaringan dan akses yang dapat dipercepat sehingga

mempersatukan peserta didik yang tersebar di berbagai tempat.

• Melahirkan inovasi yang menarik. Dengan sistem ini pembelajaran jarak jauh

akan lebih menarik, menyenangkan, dan mencerdaskan dengan melihat layar

video yang menarik dan interaktif.

• Menghemat biaya pembelajaran. Secara materi, pembelajaran jarak jauh

dapat menghemat biaya pembelajaran seperti biaya transportasi untuk

mengirim tenaga pengajar ke daerah.

• Sarana koordinasi antarpemangku kepentingan. Selain manfaat

pembelajaran, teknologi Sipena, seperti video conference, dapat digunakan

untuk koordinasi antara pemerintah pusat dan daerah maupun lintas sektor.



Penggunaan SIPENA dapat ditujukan untuk pelaksanaan program pendidikan dan

pelatihan, koordinasi, serta kegiatan lain sebagai berikut.

• Koordinasi Kementerian PPN/Bappenas dengan Kementerian/Lembaga dan

Pemda

• Koordinasi pelaksanaan diklat antara Pusbindiklatren dan program

studi/lembaga di dalam negeri dan luar negeri

• Pelaksanaan kuliah umum atau pengajaran program pendidikan yang

diselenggarakan Pusbindiklatren

• Pelaksanaan pengajaran program pelatihan yang diselenggarakan

Pusbindiklatren

• Proses pelatihan dan uji kompetensi Jabatan Fungsional Perencana

• Pembukaan dan penutupan program pendidikan dan pelatihan

• Seleksi wawancara peserta program pendidikan dan pelatihan

• Pemantauan dan pengendalian program pendidikan dan pelatihan
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D. Penggunaan Sipena

E. Jaringan Sipena

Dalam tahap awal perangkat keras Sipena terhubung dengan 8 progam

studi/lembaga program pendidikan dan pelatihan di 7 universitas yaitu (1)

Fakultas Ekonomi, Universitas Syiah Kuala (FE Unsyiah); (2) Lembaga

Penyelidikan Ekonomi dan Masyarakat, Universitas Indonesia (LPEM UI); (3)

Fakultas Ekonomi, Universitas Padjadjaran (FE Unpad); (4) Magister Perencanaan

Wilayah dan Kota, Institut Teknologi Bandung (MPWK ITB); (5) Magister

Administrasi Publik, Universitas Gadjah Mada (MAP UGM); (6) Magister

Perencanaan Wilayah dan Kota, Universitas Gadjah Mada (MPWK UGM); (7)

Magister Administrasi Publik, Universitas Brawijaya (MAP UB); dan (8) Pusat

Pengembangan Kebijakan Pembangunan, Universitas Hasanudin (P2KP Unhas).

Pada masa yang akan datang, diharapkan universitas di dalam dan luar negeri

dan lembaga pemerintah di pusat dan daerah serta institusi dalam dan luar

negeri dapat terkoneksi dengan Sipena.
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F. Perangkat Sipena

Perangkat SIPENA terdiri atas 1 set perangkat Management Central Unit (MCU),

1 set peralatan video conference type 1 (immersive), dan 12 set peralatan video

conference type 2 (mobile).

Ukuran tiap-tiap layar sebesar 55 inci untuk mendukung presentasi maupun video

conference. Dilengkapi caster (roda) untuk fleksibilitas perpindahan antarruang

kelas.



Berikut beberapa penempatan/lokasi perangkat Sipena di Gedung Kementerian

PPN/Bappenas, Gedung Pusbindiklatren, dan mitra prodi/lembaga.
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G. Lokasi Penempatan Perangkat Sipena

NO. PENEMPATAN/LOKASI PERANGKAT

1 Ruangan Data Pusdatinrebang, di 

Kantor Kementerian PPN/Bappenas 

Taman Suropati

1 set Management Central Unit (MCU), 

termasuk server/storage

2 Ruang Utama 1 Gedung 

Kementerian PPN/Bappenas Taman 

Suropati

1 set video conference type 1 

(permanen/immersive).

3 Ruang Rapat Gedung Madiun 

Kementerian PPN/Bappenas Taman 

Suropati

1 set perangkat video conference 2 display

4 Ruang SS Gedung Kementerian 

PPN/Bappenas Taman Suropati

1 set perangkat video conference 2 display

5 Ruang Kelas Gedung Pusbindiklatren 

Proklamasi

1 set perangkat video conference 2 display

6 Ruang Rapat Gedung 

Pusbindiklatren Proklamasi

1 set perangkat video conference 2 display

7 Ruang Kelas di Prodi/Lembaga 

(LPEM UI, MPWK ITB, MET Unpad, 

MAP UGM, MPWK UGM, FE Unsyiah, 

P2KP Unhas, MAP UB)

1 set perangkat video conference 2 display
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A. MENGAKSES APLIKASI SIPENA
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A.1 | Ketik sipena.bappenas.go.id pada browser internet

A.2 | Klik menu “Aplikasi Pembelajaran”
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B.1 | Login dengan NIP dan Password Simdiklat

C.1 | Klik Tombol “Forgotten your Username or Password”

B. LOGIN PESERTA

C. LUPA PASSWORD
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C.2 | Masukan NIP atau Alamat E-mail pada Kolom yang Tersedia

Jika NIP atau e-mail yang 
dimasukan valid
maka sistem akan
mengirimkan email dengan
tautan untuk reset password

C.3 | Tautan Perubahan Password akan Dikirimkan ke E-mail; 
Klik Tautan lalu Isi Password Baru pada Kolom Tersedia; 
Klik Tombol “Save changes” Jika Sudah Selesai
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D.1 | Klik Tombol Akun/Nama Anda; Klik Menu “Lihat Profil”; 
Klik Opsi “Edit Profil”

Zona waktu diperlukan agar 
pengaturan waktu tepat
untuk pelaksanaan aktifitas
pelatihan: pre-test, post-test, 
kuis, penugasan, dll

Pilih zona waktu sesuai dengan
domisili pengguna, misal: 
Asia/Jakarta, Asia/Makassar, 
Asia/Jayapura, dsb

- Jika sudah, klik Perbarui Profil

D.2 | Pilih Opsi Zona Waktu yang Sesuai

D. MENGATUR ZONA WAKTU
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E.1 | Klik menu “My courses”> “in progress”; 
Klik nama pelatihan yang diikuti

F.1 | Klik “Unggah Surat Tugas & Surat Pernyataan Kesediaan”

E. MEMILIH PELATIHAN YANG DIIKUTI

F. MENGUNGGAH SURAT TUGAS DAN KESEDIAAN
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F.2 | Klik Tab “Upload Dokumen”

F.3 | Klik Ikon “Tambah Berkas”
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F.4 | Klik Tab “Unggah Berkas” > “Choose File” > “Unggah File Ini”

F.5 | Klik Tombol “Simpan Perubahan”
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G.1 | Unduh Format Kuitansi: Klik Tab “Unduh Kuitansi.pdf”

G.2 | Unggah Kuitansi dan Buku Tabungan:
Klik Tab “Unggah Kuitansi dan copy Buku Tabungan”

Unduh blanko kuitansi, 
lalu dicetak, diisi dan 
ditandatangani

Klik tautan Upload 
Kuitansi dan copy Buku
Tabungan.

G. MENGUNGGAH KUITANSI DAN BUKU TABUNGAN
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G.3 | Unggah Kuitansi dan Buku Tabungan:
Klik Tab “Tambahkan Entri”

G.4 | Unggah Kuitansi dan Buku Tabungan:
Isi Kolom Data Rekening Peserta lalu Klik Ikon “Tambah Berkas”

Masukan Nama, nomor
rekening, nama bank.

Klik icon tambah berkas
(scan/foto buku rekening)
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G.5 | Unggah Berkas Buku Tabungan:
Klik Tab “Unggah Berkas” > “Choose File” (Pilih Berkas Scan/Foto
Buku Tabungan) > “Unggah File Ini” 

G.6 | Unggah Berkas Kuitansi:
Klik Ikon “Tambah Berkas”, Pilih Berkas Kuitansi

Unggah scan/foto kuitansi yang 
sudah diisi, seperti proses 
unggah buku tabungan. 
Jika sudah, klik Simpan
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H.1 | Klik Tautan “Bahan Ajar 1/2/3/dst.”

H.2 | Bahan Ajar/Materi akan Terbuka

Materi terbuka dengan tab 
baru. Klik tab sebelumnya
untuk kembali ke halaman

Pelatihan

H. MEMBUKA BAHAN AJAR/MATERI
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I.1 | Klik Tab “Video Pembukaan Pelatihan” atau Tab Video 
Pembelajaran Lainnya

I.2 | Video Pembukaan/Pembelajaran akan Terbuka

I. MEMBUKA VIDEO PEMBELAJARAN
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J.1 | Klik Tautan “Pembukaan Pelatihan via Zoom” atau Tautan 
Zoom/Google Meet Pembelajaran

J.2 | Tele-Conference Pembukaan/Pembelajaran akan Terbuka

Klik tautan Tele-conference akan
membuka halaman ke aplikasi
Zoom/Google Meet/ lainnya

J. MENGAKSES TELE-CONFERENCE
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K.1 | Klik Tautan Pre-Test

K.2 | Klik Tab “Mencoba test/kuis sekarang”

K. MENGIKUTI PRE-TEST



25

K.3 | Klik pada Opsi Jawaban yang Dipilih lalu Klik Tab “Halaman 
selanjutnya”

K.4 | Klik Tab “Kumpulkan semua dan selesai”

Pertanyaan dapat
dilewatkan untuk dijawab
nanti, sebelum waktu test 

habis
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K.5 | Hasil Pre-Test akan Muncul; Klik “Kembali ke kursus” untuk 
Kembali ke Opsi Pembelajaran Lainnya

L.1 | Klik Tautan “Live chat 2.1”

L. MENGAKSES LIVE CHAT
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L.2 | Klik Tautan untuk Masuk ke Ruang Obrolan

M.1 | Klik Tautan “Penugasan 2.1”

M. MENGAKSES DAN MENGUNGGAH PENUGASAN
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M.2 | Klik untuk Mengunduh Berkas Penugasan yang Tersedia

M.3 | Klik Tab “Upload Dokumen” untuk Mengunggah Tugas yang 
Telah Dikerjakan

Berkas penugasan diunduh
(terdapat tugas dan instruksi

pengerjaan). 
Tugas dikerjakan secara luring 

sebelum dikirim

File tugas yang sudah
dikerjakan kemudian

diunggah
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M.4 | Klik Ikon “Tambah Berkas”

M.5 | Klik “Unggah Berkas” > Klik “Choose File” > Klik “Unggah 
file ini” 
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M.6 | Klik Tombol “Simpan perubahan” ntuk Menyimpan Berkas 
Penugasan yang Sudah Diunggah

N.1 | Klik Tautan “Kuesioner 2.1”

Kuesioner muncul pada 
setiap sesi pembelajaran

dan pada penutupan
pelatihan

N. MENGISI KUESIONER
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N.2 | Klik Tab “jawab pertanyaan berikut”

N.3 | Isi Nama Pengajar pada Kolom yang Tersedia
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N.4 | Klik pada Opsi Jawaban Kuesioner lalu Klik Tab “Kirim 
jawaban anda” jika Sudah Selesai



PANDUAN 
PENGGUNAAN 

APLIKASI SIPENA

UNTUK PRODI DAN PENGAJAR

33





35

A.1 | Ketik “sipena.bappenas.go.id” pada Browser Internet

A.2 | Klik Menu “Aplikasi Pembelajaran”

A. MENGAKSES APLIKASI SIPENA
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B.1 | Login dengan Username dan Password WiFAST

C.1 | Masuk ke Aplikasi WiFAST, Klik Lupa Password

Prodi dan Pengajar
menggunakan credential yang 
bersumber dari aplikasi WiFAST
Untuk me-reset password
melalui aplikasi WiFAST

B. LOGIN PRODI/PENGAJAR

C. LUPA PASSWORD
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C.2  | Masukan NIP dan E-mail

D.1 | Klik Tombol Akun/Nama Anda; Klik Menu “Lihat Profil”; 
Klik Opsi “Edit Profil”

Zona waktu diperlukan agar 
pengaturan waktu tepat untuk
pelaksanaan aktifitas pelatihan: 
pre-test, post-test, kuis, 
penugasan, dll.

Jika NIP dan email yang 
dimasukan valid
maka sistem akan mengirimkan
e-mail dengan password baru

D. MENGATUR ZONA WAKTU
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D.2 | Pilih Zona Waktu yang Sesuai

E.1 | Klik menu “My courses”> “in progress”; 
Klik nama pelatihan yang akan dikelola

Pusbindiklatren menyediakan
template pelatihan untuk tiap
pelatihan yang dilaksanakan prodi

• Pilih zona waktu sesuai dengan
domisili pengguna, misal
Asia/Jakarta, Asia/Makassar, 
Asia/Jayapura, dsb.

• Jika sudah, klik “Perbarui Profil”

E. MEMILIH PELATIHAN YANG AKAN DIKELOLA
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F.1 | Klik Tautan “Permintan Pengajar/Penceramah (khusus Prodi)”

F.2 | Mengisi Form yang Tersedia lalu Klik “Kirim” 

Form terkirim akan diproses dan 
prodi/pengajar akan menerima
notifikasi tindak lanjut melalui e-
mail atau dengan mengakses
aplikasi WiFAST

Permintaan pengajar/penceramah
hanya diakses oleh user prodi yang 
terdaftar sebagai pelaksana
pelatihan di WiFAST

F. MENGAJUKAN PERMINTAAN PENGAJAR
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G.1 | Klik Tombol “Gear” lalu Klik Tombol “Hidupkan mode ubah”

G.2 | Klik Menu dari Blok Sebelah Kanan (Administrasi > 
Administrasi Diklat > Edit Setelan)

G. MENGELOLA DIKLAT/COURSE
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G.3 | Mengatur Keterlihatan dan Waktu Pelatihan

H.1 | Klik Tombol “Edit” lalu Klik Opsi “Ubah topik”

• Pelatihan dapat ditampilkan/ 

disembunyikan dari peserta

• Pelatihan dapat diatur waktu

pelaksanaan (tanggal mulai dan 

tanggal berakhir)

H. MENGELOLA TOPIK DIKLAT/COURSE
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H.2 | Klik Tombol “Tambahkan pembatasan” lalu Pilih Beberapa 
Opsi Pembatasan yang Perlu Diatur

H.3 | Atur Pembatasan pada Kolom yang Tersedia 

Pembatasan akses tiap Topik/Mata 

Ajar berdasarkan

• tanggal/waktu pelaksanaan;

• penyelesai aktivitas sebelumnya;

• grup/kelompok peserta.

Contoh Pembatasan akses

Topik/Mata Ajar berdasarkan

waktu/tanggal. Setelah pengaturan 

selesai, klik “Simpan perubahan”
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I.1 | Tiga Opsi Mengelola Video Pembelajaran

I.2 | Menambahkan Video dengan Tautan (URL): Klik Tombol       
“Tambahkan aktivitas atau sumber” lalu pilih opsi “URL”

Ada tiga cara menambahkan

video di Sipena:

1. Menggunakan URL video

2. Menggunakan embed video 

3. Menggunakan berkas/file

video

I. MENGELOLA VIDEO
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I.3 | Mengunggah Video dengan Tautan (URL):
Masukkan Nama Video, URL Video, Deskripsi Video, lalu Simpan

I.4 | Menggunakan Embed Video: Klik Tombol “Tambahkan aktivitas 
atau sumber” lalu pilih opsi “Halaman” atau “Label”

Selain tambah URL baru, bisa juga 

dengan ubah URL video dari

template yang ada.
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I.5 | Menggunakan Embed Video: Salin-Tempel Kode Embed pada 
Kolom yang Tersedia

I.6 | Mengunggah Video dengan File: Klik Tombol “Tambahkan 
aktivitas atau sumber” lalu pilih opsi “Halaman” atau “Label”

• Kode HTML embed video diambil

dari Youtube, Vimeo, atau situs 

penyedia video lainnya

• Salin-tempel kode embed video 

ke editor kode HTML

• Simpan
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I.7 | Mengunggah Video dengan File: Masukkan Nama Video dan 
Unggah File Video pada Kolom yang Tersedia

J.1 | Memperbaharui URL Tele-Conference: Pada Opsi Pembelajaran 
Daring Via Zoom 2.1, Klik Edit, lalu Pilih “Edit Setelan”

Opsi unggah file untuk

video ukuran kecil

J. MENGELOLA TELE-CONFERENCE
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J.2 | Memperbaharui URL Tele-Conference: 
Masukkan Nama, URL Tele-Conference, lalu Klik Simpan

K.1 | Mengonfigurasi Pre-Test: Pada Opsi Pre-Test, Klik “Edit”, 
lalu Pilih “Edit Setelan”

Tele-conference dapat

menggunakan Zoom, Google 

Meet, atau lainnya

K. MENGONFIGURASI PRE-TEST
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K.2 | Mengonfigurasi Pre-Test: Atur Waktu Mulai, Waktu Berakhir, 
dan Waktu/Durasi Pengerjaan Pre-Test pada Kolom yang Tersedia

K.3 | Menambah Soal Kuis: Klik “Pre-Test”; Pada Blok Sebelah 
Kanan pilih “Administrasi kuis” lalu Pilih “Edit kuis”
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K.4 | Menambah Soal Kuis: Klik “Tambah”, lalu Pilih Opsi “Sebuah
Pertanyaan Baru”

K.5 | Menambah Soal Kuis: Pilih Jenis Soal, Misal “Pilihan ganda”
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K.6 |  Menambah Soal Kuis: Masukkan Nama, Teks Soal, dan 
Jawaban pada Kolom yang Tersedia

L.1 |  Mengunggah Bahan/Materi: Klik Tombol “Tambahkan aktivitas 
atau sumber” lalu Pilih Opsi “File”

Menambahkan soal dapat dengan

memasukan satu per satu,

juga dapat menggunakan bank 

soal dan import

• Materi menggunakan file format 

PDF, karena dapat ditampilkan

langsung di atas browser

• Format file lainnya (doc, xls, dsb.) 

akan diunduh browser

L. MENGELOLA BAHAN/MATERI
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L.2 |  Mengunggah Bahan/Materi: Masukkan Nama Materi, Deskripsi 
Materi, dan Unggah Berkas/File Materi dengan Klik Ikon 
“Tambah Berkas”

L.3 |  Mengunggah Bahan/Materi: Klik “Unggah berkas”; Klik 
“Choose File”; Pilih Berkas yang Akan Diunggah; Klik 
“Unggah file ini” Jika Sudah Selesai
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L.4 |  Duplikasi Bahan Ajar/Materi: Klik “Edit” lalu Pilih 
Opsi “Duplikat”

M.1 | Memperbarui Penugasan: Pada Opsi Penugasan, Klik “Edit”, 
lalu Pilih “Edit Setelan”

Selain ditambahkan, file 

materi dapat diduplikasi

M. MENGELOLA PENUGASAN
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M.2 | Menghapus Berkas/File Penugasan: Pilih File yang Akan 
Dihapus lalu Klik Tombol “Hapus”

M.3 |   Mengatur Waktu Pengerjaan Tugas: Sesuaikan Waktu 
Pengerjaan Tugas pada Kolom yang Tersedia

Jika tidak dibutuhkan, file 

lama dapat dihapus

Penugasan dapat diatur waktu

pelaksanaannya:

• Waktu mulai tugas dikirim

• Jatuh tempo

• Batas akhir (cut-off)
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N.1 | Melihat Surat Tugas dan Kesediaan Peserta

• Melihat Surat Tugas dan Kesediaan Peserta

• Melihat Hasil Penugasan Peserta

• Melihat Nilai Hasil Test

• Melihat Nilai Keseluruhan Peserta

• Melihat Hasil Kuesioner

• Mengelola Dokumen Kearsipan

• Membuat Laporan Pelaksanaan

• Dokumentasi Pelaksanaan Pelatihan

N. PELAKSANAAN DAN SETELAH PELATIHAN
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N.2 |   Melihat Surat Tugas dan Kesediaan Peserta
Klik Tautan “Lihat Semua Ajuan”

N.3 | Melihat Surat Tugas dan Kesediaan Peserta
Aksi Penilaian>Unduh Semua Pengajuan Tugas

Akan terunduh seluruh
dokumen dalam format file ZIP
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N.4 |   Melihat Nilai Hasil Test: Klik “Pre-Test” lalu Klik “Hasil”

N.5 | Melihat Nilai Hasil Test
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N.6 |  Melihat Nilai Keseluruhan Peserta: Masuk Administrasi Nilai

N.7 | Melihat Nilai Keseluruhan Peserta: Menu Grader Report

Dropdown: Pilih Grader Report 

atau Menu: Administrasi nilai >

Grader Report

• Pilih pelatihan

• Menu Administrasi diklat > 

Pengaturan buku nilai
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47 | Melihat Nilai Keseluruhan Peserta

48 | Melihat Hasil Kuesioner
Pilih Kuesioner
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49 | Melihat Hasil Kuesioner
Klik Tab Analisa

50 | Melihat Hasil Kuesioner
Analisa Kuesioner
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51 | Mengelola Dokumen Kearsipan
Membuat Laporan Pelaksanaan

52 | Membuat Laporan Pelaksanaan
Pilih Bab

Laporan Pelaksanaan
Pelatihan terdapat di topik
terakhir, Kearsipan

- Klik tombol “Hidupkan
mode ubah”

- Klik ikon “Gear” pada bab
yang akan diisi
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53 | Membuat Laporan Pelaksanaan
Form Isi Bab

54 | Mengelola Dokumen Kearsipan
Dokumentasi Pelaksanaan Pelatihan

- Masukan isi bab
- Klik Simpan
- Isikan bab berikutnya

- Terdapat 3 direktori
dokumentasi:

- Pra Pelatihan
- Pelaksanaan Pelatihan
- Pasca Pelatihan

Pada direktori
Klik Edit > Edit setelan
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55 | Dokumentasi Pelaksanaan Pelatihan
Tambah Berkas

56 | Dokumentasi Pelaksanaan Pelatihan
Unggah Berkas

Klik tambah berkas

Unggah berkas terkait
Format PDF, DOC, XLS, dsb
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57 | Menambah Dokumen Kearsipan
Simpan
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